ovom poglavlju nauciéete kako da efektno identifi-

kujete, upotrebite i podesite razlicite aspekte inter-

fejsa SolidWorksa 2009. U izdanju 2008 Solidworks
su izvrSene neke drasti¢ne promene na interfejsu. Ako su vam
poznate starije verzije ovog programa, mozda cete Zeleti da
se zadrzite na momenat i saznate §ta je promenjeno.

Promene interfejsa u verziji 2009 uglavnom su namenjene
za ustedu radnog podrucja. Sa svakim novim izdanjem, pro-
gram obezbeduje vise opcija i funkcija, a prethodna Sema
interfejsa ne moze da se prilagodi prostoru koji je potreban
za nove funkcije. Nova Sema interfejsa tezi da alatke postavi
u zavisnosti gde su i kada su potrebne.

Neke promene su kontroverzne, tako da sam ja u ovom
poglavlju predstavio opcije za one ljude koji zele da
rade drugacije od nacina koji je pretpostavljen sa novim
promenama.

Podesavanja kontroliSu mnoge aspekte SolidWorks inter-
fejsa. Ona su detaljno obuhvacena u Dodatku B. Svaki ele-
ment interfejsa koji je identifikovan na slici 2.1 je detaljnije
opisan u posebnom odeljku u ovom poglavlju.

Kada savladate razli¢ite elemente interfejsa i podesite insta-
laciju SolidWorksa, rad sa programom postaje mnogo efi-
kasniji i laksi. Mozda cete otkriti da interfejs mozete da
savladate jedino sa puno iskustva. On je veoma slozen i moze
vas malo obeshrabriti. Mnogi korisnici pronaci ¢e dosta toga
$to nisu znali, ¢ak 1 ako su zavrsili kurs i koristili ovaj pro-
gram godinama.

U OVOM POGLAV

Identifikovanje elemenata
interfejsa SolidWorksa

Kako da interfejs radi za vas

Vezba: Upoznavanje interfejsa
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Elementi SolidWorks interfejsa

FeatureManager filter

CommandManager toolbar area

Menu Bar toolbar

Rollback bar Coordinate Triad
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Identifikovanje elemenata
interfejsa SolidWorksa

Glavni elementi interfejsa SolidWorksa su graficki prozor, gde se odigravaju sve akcije, Feature
Manager, koji lista sve funkcije u delu, Property Manager, gde se desava vecina unosa podataka, i
CommandManager/linije sa alatkama, gde moZzete da pristupite ve¢ini komandi programa.

Upotreba CommandManagerai linija sa alatkama

CommandManager je bio kontroverzni element interfejsa od njegovog predstavljanja u jednoj od
prethodnih verzija, a posebno od kada je drasticno promenjen izgled SolidWorksa 2008. SolidWorks
je izabrao da koristi najradikalnije moguce opcije za standardnu instalaciju, tako da su mnogi kori-
snici iskljucili Siroki inicijalni izgled. Ako koristite SolidWorks 2009, ,,dajte Sansu* Command
Manageru, zato Sto on Stedi prostor interfejsa, grupiSe srodne komande i nudi mnogobrojne opcije
za podeSavanje.

Promene na CommandManageru u verziji 2008 su zavrSene dopola. Po mom misljenju, promene
koje su zapocete u verziji 2008 nisu imale mnogo smisla dok nisu zavrSene u 2009. Ako ste koristili
interfejs 2009 ili 2007 prvo, a zatim isprobali 2008, to ¢ete i sami uociti.

CommandManager na neki nacin podseca na interfejs Microsoft (MS) Ribbona koji se nalazi u
pogramima Office 2007. Kreatori SolidWorksa nisu izvrs$ili striktnu implementaciju MS Ribbona,
zato Sto su zeleli da dodaju vise prilagodljivosti. Daleko kompletniji niz konfiguracijskih moguc-
nosti interfejsa dostupan je u SolidWorksu 2009. U ovom odeljku prikazacu kako da Command-
Manager 2009 radi za vas ili kako da upotrebite regularne i padajuce linije sa alatkama da biste ga
efektivno zamenili.

CommandManager

CommandManager je podrucje interfejsa koje mozete da upotrebite da biste ustedeli prostor koji
tradicionalno koriste linije sa alatkama. Njegova glavna misija je da omogu¢i lak pristup svim lini-
jama sa alatkama, pa Cak i pristup prilagodenim grupama ikonica koje nisu dostupne u standardnoj
liniji sa alatkama, bez gomilanja linija sa alatkama na ekranu.

CommandManager to izvrSava tako $to koristi male kartice ispod levog kraja podru¢ja linije sa alat-
kama da bi omogucio da se prebacite na liniju sa alatkama koja se otvori. Na slici 2.2 vidite Com-
mandManager u rezimu podeSavanja — prikazane su sve kartice koje su dostupne u standardnom
podesavanju. Da biste CommandManager prebacili u rezim podeSavanja, kliknite desnim tasterom
misa na jednu od njegovih kartica i izaberite Customize CommandManager. Alternativno, mozete
da izaberete Tools=Customize iz padaju¢ih menija
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E Da biste pristupili padaju¢im menijima u standardnom podesavanju, postavite

: ' L.g.% kursor preko logotipa SolidWorksa ili malog trougla desno od njega u gornjem

levom uglu prozora SolidWorksa (na slici 2.1 vidite padaju¢e menije). Da biste meni zadrzali u toj poziciji,
kliknite na ¢iodu na desnom kraju linije menija.

Podesavanje CommandManagera

O-8-B-%-9-8 B - Sketch2 of Part1 * (I~ Soldworks Search )2 - - AX

g Planar Surface Iig Ruled Surface E Draft Analysis @ spiit Line @ Scale + = @ @ @ @ »
o & 6 2 |
Insert Parting Shut-off Parting Tooling Core

E OffsetSurface <> Filed Surface @ Undercut Detection @ Draft e e R e

Radiste Surfsce face & sl
Q te Surf m Knit Surf o Move Face
Surfaces || Shest Wetal || Weldments | Plastics | Mold Tools | Evaluate

Podesavanje CommandManagera

Pogledajte poslednju karticu u dnu CommandManagera sa desne strane. Ako ste Zeleli da dodate
prilagodenu karticu, kliknite desnim tasterom miSa na nju i izaberite liniju sa alatkama koju zelite da
dodate. Isto tako mozete da izaberete da dodate praznu karticu i ubacite u nju pojedinu dugmad. Na
slici 2.3 prikazan je detalj opcija menija nakon klika desnim tasterom miSa na karticu.

SLIKA 2.3

Dodavanje kartica u CommandManager
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Da biste dodali pojedina¢nu dugmad, prvo potrazite dugme koje Zelite da dodate u Tools, kartici
Commands okvira za dijalog Customize, zatim prebacite CommandManager na karticu na koju Zelite
da dodate dugme i prevucite dugme iz okvira za dijalog Customize u CommandManager. Mozete da
uklonite dugmad iz CommandManagera ako ih prevucete na prazan deo grafickog prozora.

Postavljanje CommandManagera u dok

U SolidWorksu 2009 mozete da pomerite CommandManager i da ga ostavite van doka, da ga pre-
bacite na drugi monitor ili da ga postavite u dok vertikalno sa leve ili desne strane. Da biste ga
postavili u dok, kliknite i povucite bilo koje podru¢je CommandManagera bez dugmadi, kao §to je
okvirna linija. Da biste promenili poziciju doka ili pomerili iz doka CommandManager, prevucite
CommandManager na jednu od stanica doka na ekranu. Na slici 2.4 prikazan je CommandManager
van doka.
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CommandManager van doka
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Malo polje sa strelicama u gornjem desnom uglu CommandManagera koji nije u doku je opcija
Auto Collapse. U stanju u kojoj je prikazan CommandManager van doka se nece skupiti. Medutim,
ako kliknete na njega, strelica ¢e nestati, a ceo CommandManager ¢e se ponasati kao velika pada-
juca linija sa alatima. Ovo moze da bude veoma korisno, zato §to Stedi puno prostora na ekranu, ali
u isto vreme zahteva dodatni pokret miSem radi otvaranja CommandManagera. To je uobicajena
razmena u ovom interfejsu — moZzete da zamenite prostor ekrana za dodatni pokret misa ili klikove.
Ova opcija Auto Collapse je dostupna samo ako je CommandManager van doka.

PropertyManager takode moze da se pomeri van doka i ponasa se na isti nacin

W\
=5l kao i CommandManager u odnosu sa stanicama doka, opcijom AutoCollapse i
ponasanjima padajuce linije sa alatima.

Mesanje CommandManagera sa linijama sa alatkama

Da biste liniju sa alatkama postavili u liniju sa CommandManagerom, ili u gornji red ili vertikalno
sa leve ili desne strane, prevucite liniju sa alatkama na desni kraj ili na dno CommandManagera.
Prostor u tom redu ili toj koloni ¢e biti osloboden. Veli¢ina prostora koji se oslobada zavisi od
kartice sa najduzim setom ikonica, ¢ak i ako kartica nije prikazana. Da biste povecali veli¢inu pro-
stora koji je dostupan za liniju sa alatkama u istom redu gde je i CommandManager, unesite rezim
Customize CommandManager, tako Sto ¢ete kliknuti desnim tasterom misa na karticu, i izaberite
Customize CommandManager. Zatim, kruzite kroz dostupne kartice, traze¢i onu koja ima najvise
ikonica. Uklonite ili preuredite karticu sa najvise ikonica. Na taj na¢in éete napraviti prostor za linije
sa alatkama sa desne strane CommandManagera.

Da biste dobili maksimum iz ovog uredenja, najbolje je ako iskljucite tekst i opciju da koristite samo
ikonice za veliku i malu dugmad. Tekst mozete da iskljucite tako $to ¢ete kliknuti desnim tasterom
misa, izabrati CommandManager i deselektovati ikonicu Use Large Buttons with Text.
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Kartice i vrste dokumenata

SolidWorks pamti koje ste kartice prikazali u dokumentu. To znaci da, kada radite na dokumentu
dela, imacete jedan set kartica. Kada se prebacite na dokument sklopa, videcete drugaciji set kar-
tica. Isto vazi i za crteze. Vidite da se na slici 2.3 u kontekstnom meniju nalaze opcije Copy Tab
To Assemblies i Copy Tab To Drawings. One olakSavaju prilagodavanja koja primenjujete na vrste
dokumenta.

Menjanje izgleda CommandManagera

Za element interfejsa koji treba da Stedi prostor standardno podesavanje za CommandManager
sigurno zauzima veliki deo. Mnogi korisnici kada prvi put vide CommandManager pitaju se kako
da iskljuce tekst.

Tekst mozete da iskljucite na jedan od dva nacina. Laksi nacin je da kliknete desnim tasterom misa
u CommandManager i deselektujte opciju Use Large Buttons with Text, kao Sto je prikazano na
slici 2.5.

Dodavanje ili uklanjanje teksta iz dugmadi CommandManagera

o - - s =
e [ Camanbas e } L4 o -

it PR T bt B T
Pt 57t Ly Wt Pt LI
.I-YIE:E: .:--.:.-_-I| F T

i salidvorna AR E -9 8 &- Damnaifamit |

i : T ,
fastures [ Bhates | Bwtipart | OFkes Prmca | ke AN | EEEd B E 1-4

Drugi nacin da tekst uklonite iz selektovane ikonice. Da biste to uradili, prvo udite u rezim podesa-
vanja (Tools =Customize ili kliknite desnim tasterom misa na karticu CommandManager i selek-
tujte Customize CommandManager), a zatim kliknite desnim tasterom misa u CommandManager i
promenite podesavanje Show Text, kao $to je prikazano na slici 2.6. Opcija Show Text je dostupna
samo kada je ukljucena opcija Use Large Buttons With Text.

SLIKA 2.6

Menjanje podesavanja teksta za pojedina¢nu dugmad u CommandManageru
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Ne zaboravite da, prema standardnom podeSavanju, tekst ide sa desne strane ikonice, ali pomo¢u RMB
menija mozete da ga postavite ispod ikonice. Sa ovim podeSavanjima i malo strpljenja prilikom pro-
laska kroz ceo interfejs, mozete skoro potpuno da podesite izgled i funkciju CommandManagera.

Najefikasniji nacin koji najupecatljivije Stedi prostor za podeSavanje CommandManagera je da
iskljucite tekst. Ovo uredenje je prikazano na slici 2.5, na donjoj slici. Ne zaboravite da Comman-
dManager bez teksta zauzima istu visinu kao i normalna linija sa alatkama sa dodatim prostorom za
kartice na dnu. Tekst moze da bude koristan za nove korisnike ili za funkcije koje retko koristite.
Takode nemojte zaboraviti da sa iskljucenim tekstom imate prostora za vise linija sa alatkama na
kraju CommandManagera.

Finalno podesavanje za izgled CommandManagera je velic¢ina ikonica. Ovo je opcija koja je
menjana od verzije 2007 do 2008, a sada ponovo u verziji 2009, u kojoj ponovo postoji kontrola nad
veli¢inom slika ikonice u CommandManageru. Ovo podeSavanje ¢ete pronaci u okviru za dijalog
Customize (Tools= Customize), a prikazano je u gornjem desnom uglu slike 2.7. Razlika izmedu
velikih i malih ikonica je prikazana u donjem delu slike.

SLIKA 2.7

Podesavanije velikih ikonica
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Podesavanja se primenjuju na sve ikonice linije sa alatkama osim u liniji menija i RMB i ikonicama
kontekstne linije. Podesavanja se primenjuju na S liniju sa alatkama precica koju ¢u opisati kasnije u
ovom odeljku. Velike ikonice mogu da budu korisne na prikazima sa velikom rezolucijom, posebno
na laptopovima, na kojima je sam ekran mali, ali je rezolucija veoma velika. Svi snimci ekrana u
ovoj knjizi su napravljeni sa uklju¢enom opcijom Large Icons zbog poboljsane vidljivosti. Cesto su
uocljive male razlike izmedu izgleda velikih i malih ikonica.
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Ogranicenje

CommandManager je u verziji 2008 imao mnogobrojna ogranicenja, ukljucujuci i to da nije mogao
da se pomeri van doka i nije omogucavao postavljanje drugih linija sa alatkama u isti red. U izdanju
2009 je vecina ovih ogranic¢enja otklonjena.

Ako CommandManager pomerite van doka, nec¢ete mo¢i da preorijentiSete kartice horizontalno.
One ostaju vertikalne. Osim toga, ne moZzete da postavite vise redova linija sa alatkama u isti red
gde je i CommandManager koji koristi veliku dugmad sa tekstom. CommandManager ne mozete da
postavite u dok u dnu prozora SolidWorksa. Jos jedno malo ogranicenje je da, bez obzira §to verzija
2009 omogucava da postavite linije sa alatkama na desni kraj CommandManagera, ne omogucava
da ih postavite levo od CommandManagera, kao $to je bilo moguce u verziji 2007.

Ovo su relativno mala ogranic¢enja koja ostaju, ali koja ¢e mozda biti reSena u periodu od pisanja
ove knjige do trenutka kada je vi budete citali.

Upotreba linija sa alatkama

Cilj CommandManagera je da vas odvikne od upotrebe regularne linije sa alatkama - glavni cilj je
usteda prostora. Nazalost, kada ustedite na jednoj strani, obi¢no zavrsite sa nekim nedostatkom na
drugoj. U sluc¢aju CommandManagera nedostatak je pomeranje i kliktanje miSem. Mozda cCete se
nadi u situaciji da Cesto klikéete nazad i napred izmedu kartica Sketch i Features. Zbog toga, u mom
podesavanju interfejsa ja sam postavio liniju sa alatkama Sketch vertikalno sa desne strane i uklonio
je iz CommandManagera. To obezbeduje da istovremeno vidim linije sa alatkama Sketch i Features,
tako da ne treba da klikéem nazad i napred izmedu ove dve kartice.

Linije sa alatkama mogu da se ukljuce i iskljuce na nekoliko nacina. Da biste ih ukljucili, kli-
knite desnim tasterom miSa na podrucje linije sa alatkama i bic¢e prikazana lista linija sa alatkama u
SolidWorksu. U toj listi mozete da ih ukljucite ili iskljucite. Jo§ jedan nacin da to uradite je da upo-
trebite okvir za dijalog Customize (Tools=Customize ili opcija Customize blizu dna RMB liste).
Jos jedan nacin je pomoc¢u menija u View=>Toolbars.

Heads-up View linija sa alatkama

Heads-up View linija sa alatkama je novi element interfejsa u SolidWorksu 2008, a nalazi se duz
sredi$njeg dela gornje ivice grafickog prozora. Na slici 2.8 vidite standardno uredenje linije sa alat-
kama Heads-up View - prikazana je u odnosu sa ostatkom interfejsa na slici 2.1.

Heads-up View linija sa alatkama

Q@ e M@ @ b A H-Q

Ova linija sa alatkama je ograni¢ena samo na ikonice linija sa alatkama View ili Standard View.
Mozete da je podesite tako Sto ¢ete kliknuti na nju desnim tasterom misa i selektovati ili deselekto-
vati alatke koje Zelite. Jedini nacin da je iskljucite je da uklonite sve ikonice iz nje. Ako imate vise
prozora sa dokumentima ili vi$e prikaza linija sa alatkama, Heads-up View ¢e se prikazati samo
u aktivnom prozoru ili prikazu. Ova linija sa alatkama se ¢esto preklapa sa drugim elementima
interfejsa kada je poredano nekoliko prozora ili ako aktivni prozor nije maksimiziran. Moze da se
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preklopi sa PropertyManagerom ako je on izvucen iz FeatureManagera, kao i sa panelima Confir-
mationCorner ili Task.

U Poglavlju 3, ,Rad sa skicama”, detaljnije je predstavljen
ConfirmationCorner.

Linija menija i meni

Linija menija takode ima nove funkcije u SolidWorksu 2009. Prva je linija sa alatkama Menu Bar.
Ona se nalazi desno od logotipa SolidWorks u liniji naslova prozora SolidWorksa. Prema standar-
dnom podesavanju, ona sadrzi veéinu elemenata linije sa alatkama Standard, a dostupna je ¢ak i kad
nema otvorenih dokumenata. Uglavnom koristi padajuce ikonice linije sa alatkama, tako da i ona
prati trend ustede prostora po cenu dodatnog klika. Ova linija sa alatkama moze da se podesi na isti
naci kao i normalna linija sa alatkama u okviru za dijalog Customize pod karticom Commands. Ova
linija sa alatkama ne moze da se iskljuci ali mozete da uklonite sve ikonice iz nje.

¥ Na isti nacin na koji mozete da pokrenete interfejs SolidWorksa 2009 samo iz

S CommandManagera bez dodatnih linija sa alatkama mozete da uradite i sa lini-
jom sa alatkama Menu Bar, podesavajudi je sa svim padajuc¢im linijama sa alatkama. Glavna prednost ove
linije sa alatkama je da je vidljiva i kada nema otvorenih dokumenata, tako da se efikasno koristi prazan
prostor. Mozete da podesite interfejs za ekran laptopa od 12 inc¢a drugacije od onog za racunar sa Sirokim
ekranom od 24 inca.

Postoji i meni Menu Bar koji je, prema standardnom podeSavanju, sakriven. Logotip SolidWorks u
gornjem levom uglu prozora SolidWorksa ili mali trougao pored logotipa sluzi kao padajuc¢i meni
za razvlacenje menija SolidWorksa. Meniji mogu da se zakace na jedno mesto, kao §to je prikazano
na desnom kraju menija na slici 2.9. Kada je meni zakacen, linija sa alatkama se pomera udesno da
bi se prilagodila.

SLIKA 2.9

Linija menija Menu Bar i meni
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Videcete da pri manjoj rezoluciji ili nemaksimiziranim prozorima SolidWorksa mozete da naidete
na neke probleme ,,vezane* za prostor ako je meni Menu Bar zakacen i otvoren. Prozor SolidWor-
ksa na slici 2.9 je maksimiziran na rezoluciji od 1.024x768, $to je uobicajena rezolucija kada kori-
stite digitalne LCD projektore ili male notebook ra¢unare. Promene u interfejsu SolidWorksa treba
da ispitate imajuci na umu veli¢inu prikaza. MoZete da razmotrite razli¢ite setove podeSavanja za
upotrebu laptopa pri stanici doka sa velikim monitorom, upotrebu laptopa sa malim monitorom ili
upotrebu racunara sa digitalnim projektorom male rezolucije.
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Dugmad padajuce linije sa alatkama

SolidWorks ima implementirane padajuce linije sa alatkama koje Stede prostor, tako §to postavljaju
nekoliko srodnih ikonica u padajuéi meni. Na primer, alatka Rectangle sada ima nekoliko razli¢itih
nacina za kreiranje pravougaonika, sa posebnom alatkom za svaki, a sve se nalaze u padaju¢em
meniju Rectangle.

Mozete da vidite sve dostupne padajuce menije u meniju Tools=pCustomize na kartici Commands
u prvoj listi u prozoru Flyouts.

Namena padajucih menija je prvenstveno usteda prostora linija sa alatkama kada su nekoliko alatki
blisko povezane. SolidWorks je podesio padaju¢e menije u dve konfiguracije: padaju¢i meniji koji
uvek zadrzavaju istu sliku za prednje dugme (kao $to je padaju¢i meni Smart Dimension) i padajuci
meniji koji koriste poslednje upotrebljeno dugme kao sliku padajuc¢eg menija (kao $to je padajuci
meni Rectangle). Mozete da raSirite padajuci meni, tako §to éete kliknuti na strelicu koja je pove-
zana sa dugmetom padajuéeg menija. Otkricete tri vrste padajuc¢ih menija u SolidWorksu: padajuci
meniji linija sa alatkama, padajuéi meniji sa dodacima i padajuci meniji sli¢nih funkcija.

Padaju¢i meniji linija sa alatkama su izlistani u Tools=> Customize=p Commands i izlistani su iz 2D
u 3D kroz liniju sa alatkama Weldments. MozZete da promenite redosled stavki u padaju¢em meniju,
tako Sto ¢ete promeniti redosled stavki u linijjama sa alatkama. Samo prikazite originalnu liniju
sa alatkama 1 upotrebite Tools=>Customize da biste je preorganizovali po svom ukusu. Ove linije
sa alatkama ¢e uvek imati iste ikonice na vrhu. Na primer, ako koristite padaju¢i meni Reference
Geometry da biste pristupili komandi Axis, slika za ikonicu Plane ¢e ostati na vrhu. Slika na vrhu se
smatra najuobicajenijom funkcijom u toj grupi alatki.

Padajuée menije sa dodacima, kao §to je eDrawing, koje kontroliSe odredeni dodatak, uvek zadrza-
vaju istu ikonicu na vrhu.

Padaju¢i meniji koji se koriste za alatke sa slicnim funkcijama koriste na vrhu ili ikonice najce-
S¢e koriséene alatke ili uvek iste ikonice. Jedine alatke koje prate metod su alatke Sketch Entities.
Sketch Tools, a ostali padaju¢i meniji koriste sliku u samom vrhu.

Kontekstne linije sa alatkama

Kontekstne linije sa alatkama su one koje se pojavljuju u grafickom prozoru kada kliknete desnim
tasterom misa ili levim tasterom miSa na nesto. Kada kliknete desnim tasterom misa, pojavice se
kontekstna linija sa alatkama na vrhu RMB menija i prikazaée funkcije koje SolidWorks smatra naj-
Cesce koris¢enim. To je statina lista i ne menja se kad koristite dugmad. Ove funkcije su uklonjene
iz aktuelnog RMB menija i zamenjene su samo ikonicama linije sa alatkama iznad skracenog RBM
menija, kao §to je prikazano na slici 2.10.

Identi¢na linija sa alatkama se pojavljuje kada selektujete (kliknete levim tasterom misa) na stavku
na ekranu. Kada se pojavi ova linija sa alatkama, ostatak RMB menija se nece pojaviti. Saveti
ekrana su dostupni ako ne prepoznate ikonice na liniji sa alatkama.

Za referencu, ikonice u liniji sa alatkama iznad RMB menija koja je prikazana na slici 2.10 prika-
zane su u redosledu od gornjeg levog ugla: Edit Feature, Edit Sketch, Suppress, Rollback, Select
Other, Create Sketch, Hide Body, Zoom To Selection, Normal To i Appearance Callout. Videcete
da se ove selekcije ne pojavljuju ponovo u glavnom meniju.
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Kontekstna linija sa alatkama desnog klika misem
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Ove kontekstne linije sa alatkama nisu promenljive, ali mozete da ih iskljucite i da vratite RMB
menije nazad u poznatiju konfiguraciju. Da biste ih isklju¢ili, kliknite desnim tasterom misa ili
levim tasterom misa, ili i jednim i drugim, na kontekstnu liniju sa alatkama, kliknite na ToolsCusto-
mize i upotrebite opcije sa desne strane glavne kartice Toolbars, kao $to je prikazano na slici 2.11.

SLIKA 2.11

Podesavanja kontekstne linije sa alatkama
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Smatram da su RMB kontekstne linije nepotrebne, zato $to vas primoravaju da Citate ikonice i tekst
istovremeno i da pretrazujete dvodimenzionalnu listu ikonica i jednodimenzionalnu listu teksta, Sto
je za mene zbunjujuce. Ja ih obi¢no isklju¢im, tako da RMB meniji izgledaju kao i ranije.

npsgrdRelalinn

Medutim, kontekstne linije levog klika miSem smatram korisnim za Hide Sketch, Edit Feature, Edit
Sketch, Appearance Callout, relacije skice i tako dalje. Kada koristim RMB menije, trazim osnovnu
funkciju. Kada koristim kontekstne linije levog klika, trazim nesto specificno §to znam da se tamo
nalazi. Na slici 2.11 Show on selection simply se odnosi na liniju sa alatkama levog klika miSem, a
Show in shortcut menu na RMB meni.
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Namena kontekstnih linija sa alatkama je da se ustedi prostor sakupljanjem nekih komandi u liniju
sa alatkama bez teksta, umesto menija sa ikonicom i tekstom. Linije sa alatkama desnog i levog
klika miSem su iste, ali rade drugacije. Kontekstna linija sa alatkama levog klika postepeno nestaje
dok pomerate kursor dalje sa nje i postaje tamnija kako pribliZzavate mi$ prema njoj. Kada izbledi
prelazeci odredenu tacku, ne mozete da je vratite, osim ako pritisnete Ctrl i selektujete vise objekata.
Kontekstna linija sa alatkama se nece pojaviti sve dok ne otpustite Ctrl taster. Da biste se kontekstni
meni ponovo pojavio nakon $to izbledi, potrebno je da vratite kursor otprilike na mesto gde je i bio
i ponovo pritisnite Ctrl. To funkcioniSe samo za menije visestrukih selekcija gde je upotrebljen Ctrl
za selektovanje vise objekata. Ova funkcija verovatno ima gresku, nenamernu; inace bi se primenji-
vala i za selekciju jednog objekta.

Shortcut S linija sa alatkama

Linija sa alatkama Shortcut je poznata i kao S linija sa alatkama i, prema standardnom podesavanju,
mozete da joj pristupite ako pritisnete taster S. Ona moze da se podesi za svaku vrstu dokumenta,
tako da ima razlicite sadrzaje za delove, sklopove i crteze. Da biste podesili S liniju sa alatkama,
kliknite na nju desnim tasterom misa kada je aktivna i kliknite na Customize u meniju, kao $to je
prikazano na slici 2.12.

SLIKA 2.12

Linija Shortcut S

P A

Mnogi ljudi tvrde da ako imate prilagodenu S liniju sa alatkama mozete da uklonite sve ostale linije
sa alatkama iz interfejsa. Ona je korisna ako upotrebljavate ograni¢eni broj objekata skice, odnosa
skice i vrsta funkcija ili ako prosirite upotrebu padaju¢ih menija na liniji sa alatkama S. Medutim,
ako zelite da radite u nekoliko uglova programa (recimo, povrsine, aluminijum i plasti¢ni delovi),
mozda ¢e vam biti potreban dodatni prostor linije sa alatkama. Potpuno je moguce da imate pristup
vedini funkcija programa pomocu linije sa alatkama S 1 linije sa alatkama Menu Bar ili pomocu
CommandManagera. CommandManager omogucava najvecu fleksibilnost, ali zahteva i najvise
prostora, a ujedno i najvi§e vremena za podeSavanje.

Precica tastera S moze da se sudara sa podeSavanjem koje izvrsite, u zavisnosti od toga kako je pro-
gram instaliran. Da biste promenili taster linije sa alatkama S na neki drugi karakter ili da biste ga
ponovo dodelili, pratite upustva za kreiranje i odrzavanje ,,vru¢ih® tastera kasnije u ovom poglavlju
u odeljku o podesavanju. Lista precica je referencirana kao Shortcut Bar u Tools=> Customize=)
Keyboard list.
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Saveti ekrana

Jedan nacin da naucite nesto o pojedinim ikonicama je da upotrebite Tooltip, koji se pojavljuje kada
zadrzite kursor na ikonici nekoliko sekundi. Tooltip postoji u dve varijante: veliki i mali. Veliki
prikazuje naziv alatke zajedno sa kratkim opisom onoga $to ona radi, a mali samo naziv alatke.
Da biste promenili prikaz Tooltipa sa veliki na mali ili da biste iskljucili Tooltip, upotrebite opciju
menija Tools=>Customize, kao Sto je prikazano u gornjem desnom uglu slike 2.11. Pored Tooltip
balona, pojavljuju se saveti i u statusnoj liniji u dnu ekrana kada se kursor nalazi na ikonici. Na slici
2.13 prikazano je poredenje izmedu velikog i malog Tooltipa.

SolidWorks koristi veliki Tooltip prema standardnom podesavanju, mada moze da prikaze i mali
Tooltip.

- E M@ Opcija menija Toolss Customize nije aktivna osim ako je otvoren SolidWorks
: lrsiemicl==lsl dokument. Da biste pristupili opciji Tools, Customize, prvo otvorite SolidWorks
deo, sklop ili crtez. Tools, Customize se razlikuje od opcije menija Customize koja se nalazi u svim
SolidWorks menijima. Opcija menija Customize je opisana kasnije u ovom poglavlju.

Upravljanje linijama sa alatkama

Nakon svega toga, ako i dalje zelite da radite sa standardnim linijama sa alatkama, veoma je lako
pomeriti, ukljuciti, iskljuciti i dodati ikonice u liniju sa alatkama. Veoma je vazno da zapamtite da
razli¢ite vrste dokumenata zadrzavaju razlicita podesavanja linije sa alatkama; na primer, linije sa
alatkama koje vidite sa otvorenim dokumentom dela razlikuje se od linija sa alatkama koje vidite
za crteze.

Kada radite na delovima, vazno je da imate aktivne linije sa alatkama Sketch i Features. Kada
radite na crtezu, nikada necete upotrebiti liniju sa alatkama Features, ali ¢ete Cesto koristiti liniju
sa alatkama Sketches. To vazi i za sklopove. Mozda Cete Zeleti da prikazete neke dodatne linije sa
alatkama i da eliminiSete ostale. Zbog toga, kada se prebacite iz dokumenta dela u dokument crteza,
videcete prilagoden prikaz sa poveéanim ili smanjenim prostorom, koji zahteva linije sa alatkama
zbog promene.

% Najbolje je da podesite linije sa alatkama za svaku vrstu dokumenta tako da
: % one zauzimaju istu koli¢inu prostora - na primer, za dva reda na vrhu i jednu
kolonu sa desne strane. Na ovaj nacin, menjanje izmedu vrsta dokumenta nije neuskladeno sa prome-
nama veli¢ine grafickog podrucja za svaku promenu.
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Pomeranje linija sa alatkama

Da biste pomerili liniju sa alatkama, mozete da kliknete kursorom na dvostruku liniju na levom
kraju linije sa alatkama, kao $to je prikazano na slici 2.14. Kursor se menja na ¢etvorostranu strelicu
i tada mozete da prevucete liniju sa alatkama gde god zelite. Linije sa alatkama se stavljaju u dok
vertikalno ili horizontalno. Mozete da promenite linije sa alatkama koje nisu u doku tako da imaju
redove 1 kolone. Ovo uredenje se obi¢no koristi sa linijom Selection Filter, koja Cesto ostaje van
doka i kompresovana je u blok koji je Sirok kao tri ili etiri bloka.

Dvostruke linije omogucavaju da pomerate linije sa alatkama.

3%::'% & @

Ako prozor SolidWorksa nije dovoljno §irok za liniju sa alatkama tako da ona stane preko celog
ekrana, dvostruko kliknite na strelice, kao $to su one koje su prikazane na slici 2.15 na kraju odse-
Cene linije sa alatkama. Kada kliknete na dvostruke strelice, pojavice se padajuca linija sa alatkama
sa nedostaju¢im ikonicama, kao §to je prikazano na slici 2.16.

Odsecena linija sa alatkama prikazuj5e dvostruke strelice.
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Mozete da prikazete odsecenu liniju sa alatkama tako 5Sto cete kliknuti na dvostruke strelice.
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Padajuce linije sa alatkama

Mozete da upotrebite bilo koju liniju sa alatkama kao padajucu liniju sa alatkama. Na slici 2.17 pri-
kazana je lista padajucih linija sa alatkama koje su potpuno jednake kao lista svih linija sa alatkama.
Padajuce linije sa alatkama su odli¢na funkcija za uStedu prostora za alatke koje ne koristite Cesto,
ali dovoljno Cesto da pozelite da ih trazite u menijima. Da biste upotrebili liniju sa alatkama kao
padajucu liniju sa alatkama, selektujte je iz liste Flyout Toolbars i prevucite je na postojecu liniju sa
alatkama. Ona se prikazuje sa streliceom sa desne strane. Klik na strelicu dovodi do toga da se sve
alatke privremeno prikazu dok ne kliknete na ikonicu ili negde drugo.
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Padajuce linije sa alatkama se nalaze na kartici Commands u okviru za dijalog Customize.
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Da biste dodali ikonice u padajuée linije sa alatkama, privremeno prikazite regularnu liniju sa alat-
kama koja odgovara padajucoj liniji sa alatkama i dodajte ikonice u regularnu liniju sa alatkama.
Kada zavrsite dodavanje ili uklanjanje ikonica, iskljucite regularnu liniju sa alatkama; promene su
primenjene na padajucu liniju sa alatkama.

I Ako Zelite da kreirate posebnu liniju sa alatkama, prilagodite postojecu za svoje
potrebe. Na primer, posto ne koristim liniju alatki Tools, ja sam uklonio sve regu-
larne ikonice iz nje i zamenio ih relevantnim padajucim linijama sa alatkama koje redovno koristim. To mi
omogucava da smanjim prostor i nemam neupotrebljenih ikonica u mojim linijjama sa alatkama.

Full Screen rezim

Full Screen rezim omoguéava da brzo prebacujete prikaz tako da budu prikazani samo graficki
prozor i Task panel; FeatureManager, meniji, linije sa alatkama i statusna linija su skriveni. Alterna-
tivno, mozete da sakrijete samo FeatureManager ili linije sa alatkama.

U Full Screen rezimu i dalje mozete da pristupite menijima tako sto ¢ete kliknuti kursor duz gornje
ivice prozora.

B Da biste se prebacili u Full Screen rezim, pritisnite taster F11.
B Da biste ukljucili prikaz linija sa alatkama, pritisnite taster F10 (vidite sliku 2.18).

B Da biste ukljuculi prikaz FeatureManager, pritisnite taster F9.
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Prozor SolidWorksa sa svim linijjama sa alatkama skrivenim pomocu tastera F10
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Prilagodavanje toka rada

Kada prvi put instalirate i pokrenete SolidWorks program, prikazan je ekran SolidWorks Welcome,
kao na slici 2.19, koji nudi opciju za prilagodavanje interfejsa pomocu jednog od tri unapred pode-
Sena paketa opcija. Napravljeni su Special meni i podeSavanja linije sa alatkama za Consumer pro-
duct dizajn, Machine dizajn ili Mold dizajn. Nakon §to je program inicijalno instaliran, videcete
ovaj ekran samo jednom, ali moZete da promenite sve opcije na drugim mestima, ukljucujuci i
karticu Options iz menija Tools=>Customize.

Tri prilagodavanja toka rada uticu na interfejs:
B Consumer product design dodaje liniju sa alatkama Surfaces u CommandManager.
B Machine design dodaje linije sa alatkama Sheet Metal i Weldments u CommandManager.
B Mold design dodaje linije sa alatkama Surfaces i Mold Tools u CommandManager.

Sli¢ne promene su izvr§ene u menijima za sakrivanje ili prikazivanje selekcija menija. Vise infor-
macija o sakrivanju i prikazivanju stavki menija naci ¢ete kasnije u ovom poglavlju.

Ako zelite da selektujete drugu opciju nakon inicijalnog podesavanja, idite na Tools=yCustomize-
= Options, gde mozete da specifikujete drugaciji izbor. Na slici 2.20 prikazana je kartica Options
okvira za dijalog Customize.
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SLIKA 2.20

Kartica Options okvira za dijalog Customize, gde mozZete da izaberete drugacije podesavanje toka
rada

Customize ()%
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Shortout customization otk Flow customization
Toggles the visibility of toolbars
and menus by your areas of
expertiss,
Bezzlobafauls [] Consumer product design
[[IMachine design
Menu customization
[C1Muold design
Shiwe Al
Reset to Defaults
keyboard customization
Reset bo Defaults
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Meniji
Svako ima sopstveni stil rada. Na primer, neki ljudi vole da koriste menije, a drugi ne vole. Neko
voli da koristi precice sa tastature, a drugi viSe vole miS. Primer alatke koja nema ekvivalent u liniji

sa alatkama je ViewspModify=> Section View, koja se koristi za menjanje aktivnog odeljka pode-
Savanja prikaza.

Najcescée upotrebljavane stavke menija se nalaze u menijima View, Insert i Tools. Svi meniji koji su
prikazani u ovom odeljku imaju ukljucene sve moguce selekcije. Kao rezultat, meni View na slici
2.21 moze da sadrzi opcije koje nisu dostupne na vaSem rac¢unaru. Podesavanje menija je opisano
kasnije u ovom poglavlju. Na slici 2.21 takode su prikazani meniji Insert i Tools, zajedno sa slikom
menija sa aktiviranim Customize Menu reZimom.

Meni View se primarno koristi za ukljuéivanje ili iskljuc¢ivanje vidljivosti vrsta objekata, kao $to su
ravni, skice ili privremene ose, §to mozete da uradite i pomocu precica sa tastature ili tako Sto éete
dodati stavke u liniju sa alatkama View.

SLIKA 2

Popularni meniji
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Meni Insert se najcesce koristi za kreiranje vrsta funkcija za koje nemate ikonicu u liniji sa alatkama
na ekranu. Na primer, iako se alatka Move Face nalazi samo u liniji sa alatkama Mold Tools, ona
ima mnogo vise funkcija pored dizajna kalupa. Alatku Move Face mozete da pronadete u meniju
Insert=) Face.

Meni Tools se primarno koristi za objekte skice ili alatke za koje nemate ikonicu na ekranu. Neko-
liko drugih Cesto upotrebljavanih alatki, kao $to su Measure, Equations, Customize i Options, takode
je dostupno u ovom meniju.

Mozete da podesite menije tako §to ¢ete dodati ili izbrisati stavke. Upotrebom opcije Customize
u dnu bilo kog menija, ukljucujuéi i precicu (desni taster misa), mozete da uklonite stavke iz bilo
kog menija, tako Sto cete iskljuciti oznaku potvrde pored alatki koje ne koristite. Da biste vratili
uklonjene stavke, vratite se u meni Customize ili idite na Tools=» Customize=> Options i kliknite na
dugmad Reset to Defaults za podeSavanje menija i precica.

§ Pazite da ne pomesate selekciju Customize Menu i selekciju menija Customize...
u meniju Tools. Na slici 2.21 prikazan je meni Tools koji je prilagoden.

Okvir za dijalog Tools=»Customize=>Options, koji je prikazan na slici 2.21, sadrzi meni Shortcut
(desni klik miSem) i opcije Menu customization. Ove opcije omogucavaju da prikazete sve stavke
menija za obe vrste menija u jednom potezu. Prema standardnom podesavanju, neke stavke su skri-
vene u razli¢itim menijima. PodeSavanje tastature je opisano kasnije u ovom poglavlju. Precice na
tastaturi se generalno zovu i ,,vruéi® tasteri.

% Terminologija SolidWorksa za menije precica, preCice tastera Alt, liniju sa Shortcut
- Sl S | podesavanje Shortcuts/Keyboard malo je zbunjujuca, zato $to se ovi termini
poklapaju, a nisu srodni. Zbog toga, ja ¢u od sada meni precice zvati RMB (right mouse button) meniji,
zato $to je to standardna terminologija medu korisnicima SolidWorksa. Precice korisnici takode zovu
Lvruci” tasteri. Linija Shortcut e se zvati linija sa alatkama S, a precice tastera Alt e se zvati Alt-tasteri.

Kursori

Kursori SolidWorksa su kontekst senzitivni i menjaju svoj izgled i funkciju u zavisnosti od situa-
cije. Kursori skiciranja prikazuju olovku i vrstu objekta skice koji trenutno skicirate. Kursori skici-
ranja takode prikazuju neke informacije o dimenzijama o objektu koji skicirate, kao §to su duzina ili
pre¢nik. Povratna informacija kursora skiciranja je potrebna za brzo i tacno skiciranje.

v, Da biste naudili vise o povratnoj informaciji kursora skiciranja,
vidite Poglavlje 3, ,Rad sa skicama”.

Kursor za selektovanje se menja u zavisnosti od stavke preko koje ga pomerate. Simboli kursora
pomazu kao podsetnik kada su aktivni filteri selekcije. Kursor je ¢esto dostupan kao dugme OK. Na
primer, nakon selektovanja ivica za funkciju Fillet, RMB funkcioniSe kao OK dugme. Na slici 2.22
prikazani su razli€iti kursori i njihov znacaj.
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Razli¢iti kursori SolidWorksa

Select
OK sketch Sketch
Select selection plane line
I; o
L - B B

Prozori FeatureManager i PropertyManager

Prozor FeatureManager je panel sa leve strane ekrana koji prikazuje listu funkcija sa opisom kako
je deo bio graden. Korisnici SolidWorksa troSe prili¢no puno vremena koriste¢i FeatureManager za
editovanje ili ispitivanje modela. Na slici 2.23 prikazan je FeatureManager za jednostavan model.

SLIKA 2.23

FeatureManager za jednostavan model
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Upotreba FeatureManagera

Na vrhu FeatureManagera nalazi se linija razdvajanja koja omogucava da razdvojite prozor Featu-
reManagrea na dva prozora, tako da mozete da prikazete FeatureManager i jo$ jedan prozor, kao
Sto je PropertyManager. Male strelice u sredini desnog separatora mogu da skupe FeatureManager
zbog povecanja prostora ekrana (F9 taster takode skuplja ili otvara FeatureManager - pogledajte
sliku 2.23).
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Display panel

Display panel mozete da otvorite iz FeatureManagera ako upotrebite dvostruku strelicu u gornjem
desnom uglu. On pomaze da vizualizujete gde su primenjeni izgledi i skriveni objekti u dokumentu
dela i dodatne funkcije u dokumentu sklopa. Veoma je koristan kada trazite koje su boje primenjene
na model na nekom drugom nivou, a ne na nivou dela.

Y. lzgledi su opisani detaljnije u Poglavlju 5, ,Upotreba tehnika
vizuelizacije”.

Rollback linija

Linija Rollback u dnu FeatureManagera omogucava da vidite deo u razli¢itim stanjima istorije.
Mogu da budu dodate funkcije dok se linija rollback nalazi na bilo kojoj lokaciji. Model moze da
bude snimljen dok se vraéaju koraci.

FeatureManager Filter

Jedan od najkorisnijih elemenata FeatureManagera je FeatureManager Filter. On se nalazi na vrhu
FeatureManagera. Ako ukucate tekst u filter, SolidWorks ¢e potraziti naziv funkcije, opise, komen-
tare, tagove i nazive dimenzija za tekst koji se poklapa sa nizom i prikazace samo poklapajuce funk-
cije u prozoru. To vazi i za sklopove gde mozete da filtrirate nazive delova ili parametre dokumenta.
Filter je veoma koristan za brzo pronalazenje delova, funkcija, kolega ili bilo ¢ega drugog §to se
pojavljuje u FeatureManageru dela ili sklopa.

Upotreba PropertyManagera

PropertyManager je mesto gde podesavate veéinu parametara funkcija i gde editujete parametre
selektovanih objekata, kao $to su elementi skice. Mozete ru¢no da se prebacite na PropertyManager
pomocu kartica na vrhu panela Display ili da mu omogucite da se automatski sam pojavi kada je
potreban unos. Kartica skroz levo u redu ikonica je kartica FeatureManager, druga sleva je kartica
PropertyManager, druga sdesna je kartica ConfigurationManager, a skroz desno je kartica TolAnal-
yst. U ovom podruc¢ju mogu da se pojave i druge ikonice za crteze ili za ukljucene dodatke, kao §to
su PhotoWorks ili SolidWorks Simulation (prethodni COSMOS). Kartica ConfigurationManager je
detaljnije opisana u Poglavlju 10, a kartica TolAnalyst u Poglavlju 23.

Jedna od prednosti postavljanja okvira za dijalog u PropertyManager je $to se Stedi puno prostora
ekrana. Sa druge strane, Cesto ¢e biti potrebno da kreirate selekcije iz FeatureManagera u isto
vreme kada se otvori PropertyManager i zauzme svoje mesto. Ovo ponasanje automatskog otva-
ranja kontroliSu podeSavanja u meniju Tools=> Options=> System Options= General=> Auto-show
PropertyManager.

Moja omiljena opcija za rad sa PropertyManagerom je da ga otkacim iz FeatureManagera tako
da mogu da se vide jedan pored drugog, umesto jedan ili drugi. PropertyManager koji moze da se
otkaci je novina u SolidWorksu 2009. Da biste ga otkacili, prevucite ikonicu sa kartice van grafic-
kog podrucja i otpustite. Jednom otkacen, PropertyManager mozete da pomerite na drugi monitor,
da ostavite da ,,pluta® u prozoru SolidWorksa ili da ga postavite u dok. Da biste ga vratili pod Fea-
tureManager, samo ga prevucite nazad na vrh FeatureManagera 1 dozvolite da se prilepi na mesto,
a zatim otpustite taster misa.
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Ako vam se ne dopada PropertyManager koji mozete da otkacite, upotrebite razdelnu liniju iznad
koje cete staviti FeatureManager, a ispod nje PropertyManager ili upotrebite padajuc¢i FeatureMa-
nager. Kada kreirate ili editujete funkciju, pristupite padaju¢em FeatureManageru tako $to ¢ete dvo-
struko kliknuti na naziv funkcije u vrhu PropertyManagera. Padaju¢i FeatureManager je prikazan
samo sa desne strane regularnog FeatureManagera u glavnom grafi¢kom prozoru; on je providan da
bi omogucio da kroz njega vidite model. Razli¢iti na¢ini kombinovanja FeatureManagera i Proper-
tyManagera prikazani su na slici 2.24.

Otkaceni PropertyManager, padajuci FeatureManager i razdeljeni FeatureManager
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Task panel

Prema standardnom podesavanju, Task panel se nalazi sa desne strane prozora SolidWorksa, mada
moze u potpunosti da se pomeri van doka. Ako zelite da bude otvoren, kliknite na ¢iodu u gornjem
desnom uglu panela. Task panel je prikazan na slici 2.25.
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Task panel je dom za nekoliko panela:

B SolidWorks Resources. Ovo su korisni linkovi za Sablone, uputstva, tehnicku podrsku,
novosti, GlobalSpec pretragu, savet dana i druge izvore.

B Design Library. Ovo ukljucuje lokalno skladistene biblioteke, palete sa alatkama i 3D
Content Central. Ova kartica sadrzi i SolidWorks Content - on se sastoji od dodatnih
izvora biblioteke koje mogu direktno da se daunloduju iz Task panela.

B File Explorer. Ima interfejs slican Windows Exploreru, koji mozete da upotrebite za
pronalazenje fajlova.

B SolidWorks Search. Ako imate instaliran Windows Desktop Search sa SolidWorksom
2007 i ako ste indeksirali fajlove, mozete da izvrsite pretrage koje ukljucuju naziv fajla i
sopstvene parametre.

B View Palette. Ova paleta omogucava da vizuelno selektujete prikaze i da ih prevucete na
list crteza.
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B RealView. Omogucava da izaberete izgled i scene za SolidWorks dokumente.

B Custom Properties. Nova funkcionalnost u 2009 omogucava da kreirate sopstveni
interfejs unutar Task Panel kartice, koji ¢e pomoci da brzo unesete sopstvene parametre,
lako i tacno.

B Recovered documents. Nakon pada, automatski vraceni dokumenti su izlistani na ovoj
kartici Task panela za specijalnu namenu.

Statusna linija

Statusna linija je nenametljiv nacin na koji SolidWorks komunicira i pruza korisniku informacije.
Ona se nalazi u dnu ekrana i mozete da je ukljucite iz menija View. Na slici 2.26 prikazana je ,,u
akciji“.

SLIKA 2.26

Statusna linija prikazuje Tooltip za alatku Sketch Circle.

sketches a dircle, Select the center of the circle, then drag to set its radius, -1.995n  0.364n  Oin Under Defined | Edidng Sketch2 || @ 2]

Statusna linija moze da prikaze sledece informacije, indikatore i ikonice:

B progres ucitavanja delova, sklopova ili crteza

B Tooltips za komande
B  mere
B status skice za aktivnu skicu
B kontekstno editovanje
B Suspend Automatic Rebuilds
B ikonice koje omogucavaju da ukljucite ili iskljucite Quick Tips
B razmeru lista za crteze
B poziciju kursora za crteze i skice
B da li editujete list, format lista ili prikaz crteza
Tagovi

Tagovi rade kao parametri dokumenta, osim §to njima nije potreban naziv parametra; koriste samo
vrednost. Tag smatrajte jednostavnom klju¢nom recju koju mozete da povezete sa delom u sklopu
ili ¢ak funkcijom u delu. Tagovi se pretrazuju pomocéu SolidWorks Explorera ili FeatureManager
Filtera. MoZete da ih dodelite tako $to ¢ete kliknuti na Zutu ikonicu taga u statusnoj liniji u donjem
desnom uglu prozora SolidWorksa. Na slic 2.27 prikazan je tag koji je dodat funkciji.
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SLIKA 2.27

Dodavanje taga funkciji

bushing seat
casting web
lube port

pivot boss

Tags: I

Extrusion Extrude3

Quick Tips

Quick Tips se pojavljuju u padaju¢em prozoru u donjem desnom uglu grafickog prozora. Mogu da
se menjaju dok radite; osetljivi su na kontekst u kojem radite. Oni su odli¢an naéin za nove kori-
snike ili korisnike koji retko koriste SolidWorks za ucenje ili za podsecanje za sledece korake koji
su im dostupni. Mozete da aktivirate i deaktivirate Quick Tips pomocu ikonice sa znakom pitanja u
donjem desnom uglu prozora SolidWorksa u statusnoj liniji. Na slici 2.28 prikazan je prozor Quick
Tips ,,u akeiji®.

SLIKA 2.28

Quick Tips u akciji
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2D emulator komandne linije

Ovo je alatka specifi¢na za ljude koji prelaze na SolidWorks iz AutoCAD-a. Kao §to naziv ukazuje,
ona dodaje komandnu liniju u dno prozora SolidWorksa koja radi kao komandna linija u Auto-
CAD-u. Dostupne komande su prilicno ograni¢ene u poredenju sa onim koje su dostupne u Auto-
CAD-u. Ova alatka funkcioniSe samo u rezimu 2D skice, na listu za crtanje ili u prikazu crteza; ne
radi u 3D skici. 2D Command Line Emulator je prikazan na slici 2.29.

2D Command Line Emulator ,u akciji”

-+

[ e T

<

SMAP ORTHO| GRID

To point: 1.1

To point: 1.0

To point *Cancel*
Conmand: 1

From point: 1.0

To point

Ready

Dostupne alatke za skiciranje u 2D Command Line Emulatoru ukljucuju Align, Arc, Array, ‘Cal,
Chamfer, Chprop, Circle, ‘Color, Copy, DDcolor, Dim, Dist, Ellipse, Erase, Exit, Extrude, Fillet,
‘Grid, Line, List, Massprop, Mirror, Move, Offset, ‘Ortho, ‘Osnap, ‘Pan, Plot, Point, Polygon,
Qsave, Rectangle, ‘Redraw, ‘Redrawall, Revolve, Rotate, Save, Saveas, ‘Snap, Spline, Trim, U
(undo), ‘Units, “View i ‘Zoom. Komande ispred kojih se nalazi apostrof (“) mogu da se upotrebe kao
transparentne, bez napustanja aktivne komande. Videcete da se ¢ak i kursor menja na koncanicu.

Najbolji nacin da naucite novi programski paket je da prihvatite novi nacin, a
= ne da se drzite starog. lako ¢ete mozda otkriti da je rad u 2D Command Line
Emulatoru mnogo prijatniji, necete postici iste rezultate kao sa standardnim rezimom skiciranja
SolidWorksa. Na primer, rezultirajuci objekti skice koji su kreirani pomoc¢u 2D Command Line Emulatora
nisu ograniceni ni na koji nacin, a krajnje tacke se ¢ak i ne spajaju. Mozete da iskljucite 2D Command Line
Emulator tako 5to Cete izabrati Tools=>Add-ins.

\KSA
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Neka interfejs radi za vas

Kao inzenjeri i dizajneri, mi svi volimo da vr§imo podeSavanja da bismo optmizovali efikasnost i
primenili na$ liéni pecat. Kada je instaliran program SolidWorks, interfejs je funkcionalan, ali ne
i optimalan. U najnovijim izdanjima nove funkcije u SolidWorksu teze da koriste najradikalnije
opcije koje su dostupne kao standardna podesavanja. Na prethodnim stranicama opisao sam uprav-
ljanje i podesavanje linija sa alatkama i menija. U podsetniku ovog poglavlja opisao sam detaljnije
podesavanje interfejsa i preporucio neke strategije koje mozete da upotrebite kao pomo¢ u podesa-
vanju radnog okruzenja.

Podesavanje boja

Treba da pazite na nekoliko detalja pre nego Sto promenite sve standardne boje u interfejsu
SolidWorksa na neke koje smatrate odgovarajuc¢im. Izmedu ostalog, SolidWorks ne¢e promeniti
automatski boju teksta da bi on bio kontrastan sa pozadinom. Kao rezultat, ako podesite pozadinu
na crnu boju, a tekst je crn, necete moéi da vidite tekst. Ovo je nekim ljudima prili¢no o¢igledno,
ali AutoCAD automatski menja boju teksta da bude kontrastan sa pozadinom, tako da ¢e korisnici
AutoCAD-a ovo smatrati manom.

Standardne boje selekcije

Izmedu izdanja 2007 i 2008 SolidWorks je promenio nekoliko standardnih boja koje su upotre-
bljene u interfejsu. Medutim, neée svi korisnici odmah videti ove promene. Posto je program inici-
jalno izdat 1995. godine, boja za selektovane stavke je bila zelena. Korisnici su zasnovali svoje boje
za selekciju dela prema ovom standardnom podesavanju, generalno izbegavajuci zelenu boju da bi
selekcije mogle lakse da se vide.

Pocevsi sa izdanjem 2008, boja selekcije je plava. Medutim, ovo je aktuelno samo ako imate novi
racunar, bez prethodne instalacije SolidWorksa. Ako vas racunar ima prethodnu verziju SolidWor-
ksa, selekcija ¢e biti zelene boje i u izdanju 2008, ali ako stavite verziju 2008 ili noviju na racunar
na kojem nikada nije postojala verzija SolidWorksa, dobicete plavu boju selekcije.

Da li je stvarno vazno da li je boja selekcije zelena ili plava? Nije. Ono §to je vazno su predvidivost
i doslednost interfejsa. Standardna boja selekcije se menja od jedne verzije do druge i ne verujem
da ¢e to pozitivno uticati na korisnost programa. Ako promena boje ima negativan efekat na vasu
upotrebu programa, znajte da mozete da je vratite na onu koju zelite. Nacin kako se menja boja
selekcije opisan je u ovom odeljku.

RealView je hardverska tehnologija vizuelizacije u SolidWorksu koja je razvijena u nekoliko izda-
nja programa, a detaljnije je opisana u Poglavlju 5, ,,Upotreba tehnika vizuelizacije®.

Sve boje interfejsa se kontroliSu u meniju Tools=> Options=> Colors. Boja selekcije se podesava
opcijom Selected Item 1, kao Sto je prikazano na slici 2.30.
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Menjanje boja interfejsa
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Ne zaboravite da mozete da podesite kolornu Semu. Ako zelite da promenite boje koje su upotre-
bljene u interfejsu, preporucujem da snimite podesavanja kao kolornu Semu, tako da kasnije mozete
lakse da ponovo kreirate Semu ili da je prebacite na drugi racunar. Kolorne Seme se ¢uvaju u Win-
dows registru, a ne kao posebni fajlovi. Da biste podesavanja boja prebacili na drugi racunar, upo-
trebite Copy Settings Wizard ili ru¢no kopirajte podatke iz Windows registra.

Pre nego Sto izvrSite promene, razmislite o snimanju pocetnih podesavanja kao posebne Seme tako

da mozete da ih vratite ako vam bude potrebno.

Menjanje Windows registra moze da utice na instalaciju programa i performanse
hardvera. Menjajte registar samo ako stvarno znate $ta radite.
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Pozadinske opcije

Neke boje treba izbegavati za pozadinu ili bi trebalo da izvrSite i neke druge promene ako izaberete
odredene boje. Crna se koristi za potpuno definisane skice, dimenzije, tekst FeatureManagera i
beleske. Plava pozadina moze da maskira poddefinisane boje skice. Svetlozelena pozadina moze
da izazove probleme sa vidljivos¢u objekata. Svetlocrvena, pored toga $to je tesko u nju gledati ceo
dan, nema dobar kontrast sa nekim crvenim beleznicima i bojama koje oznacavaju gresku.

Bilo koju boju pozadine da izaberete, objekti i funkcije ce se tesko videti. Zbog toga, mnogi kori-
snici biraju gradijentnu pozadinu koja omogucava izbor boja na kojima su objekti uvek vidljivi
na jednoj ili drugoj polovini ekrana. Ako ceo dan gledate u beli ekran, to moze da bude veoma
neprijatno za vase o¢i, pa zato izaberite neku boju koja omogucava da vidite sve sa “prihvatljivim”
kontrastom, a da ipak ne bude bljestavo i svetlo. Veoma veliki kontrast je takode neprijatan za oci,
a mali kontrast otezava raspoznavanje objekata na ekranu.

Treba da razmotrite $ta je svrha pozadine. Neki ljudi koji kreiraju prezentacije mozda zele da poza-
dina bude atraktivna, ali da ne ometa sadrzaj. Drugima je pozadina mozda potrebna samo zbog kon-
trasta sa sadrzajem, ali tako da ne bude neprijatno za oci. Za pisanje knjige pozadina treba da bude
bela da bi se poklapala sa stranicom. Ni jedna Sema nec¢e odgovarati za sve potrebe.

Pored boja i gradijenata, mozete da upotrebite sliku kao pozadinu grafickog prozora. Time sti-
cete viSe mogucnosti za prilagodavanja, a nekoliko uzoraka slika je ve¢ dostupno u standardnim
podesavanjima.

RealView takode dodaje neke mogucnosti sa scenama. Scene mogu da budu primenjene sa kartice
RealView na Task panelu. RealView nudi tri razli¢ite vrste scena: Basic, Studio i Presentation. Ja
mislim da je Studio najbolja scena kada vam treba nesto od te vrste. RealView je, zajedno sa sce-
nama, detaljnije opisan u Poglavlju 5.

Strategije podesavanja

Mozete veoma jednostavno da podesite mnoge aspekte SolidWork interfejsa, ukljucujucéi:
B linije sa alatkama

menije

boje pozadine ili slike

PropertyManager skinove

lokaciju Task panela

,vruce tastere

makroe
B programiranje prilagodenih programa

Da li treba ili ne treba da podesite svaku od prethodnih stavki zavisi delimi¢no od toga koliko
vremena i energije imate na raspolaganju i koliko novaca ste spremni da potrosite na prilagodeno
programiranje.
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Pristupi ,vrucih” tastera

Neki ljudi vise vole da koriste tastaturu nego mis$. Ako je vasa koordinacija oko-ruka losa, kao §to
je kod mene, i vi éete verovatno izabrati ovaj pristup. Ja mogu da kucam bez gledanja u tastaturu,
ali, kada koristim mi$, potraje nekoliko sekundi dok ,,naciljam® ikonicu i kliknem na nju. To znaci
da podesavam SolidWorks da koristi $to vise ,,vru¢ih® tastera i uklanjam ikonice iz interfejsa ako ih
imam na ,,vru¢em* tasteru. Nazalost, moja memorija je losa, kao i moj vid, tako da je malo proble-
maticno pamtiti 75 ,,vru¢ih® tastera. Priznajem da imam odStampanu njihovu listu koja je zalepljena
na stranicu mog monitora. lako potreba da ¢itam listu da bih pronasao odredeni ,,vruci* taster pobija
svrhu upotrebe ,,vru¢ih® tastera, ja to ipak prihvatam kao pomo¢ u ucenju. Ovo je problem koji se
reSava sam od sebe (,,vruce™ tastere koje najvise koristim najbrze sam naucio).

Ja generalno ne preporucujem standardizaciju Sema ,,vruéih® tastera za vise korisnika, osim ako
ih svi korisnici prihvate. Razlog za pisanje ovog odeljka je Cinjenica da svi pamtimo na drugaciji
nacin.

Svim komandama koje ja koristim vise puta u toku od sat vremena vredi dodeliti ,,vru¢i® taster.
Volim da koristim aliteraciju kada dodeljujem tastere da bih pomogao mojoj loSoj memoriji. Najce-
$¢e upotrebljavanim komandama dodeljeni su ,,vruéi* tasteri od jednog slova, a manje upotrebljava-
nim komandama kombinacije. Stoga, Tools Options je povezan sa O, Measure sa M, Select Vertex
sa Shift+V, a Curve Projected sa Ctrl+]J (Ctrl+P je Windowsova standardna precica za komandu
Print). Drugi ljudi vole da grupiSu tastere u kombinacije koje je lako dohvatiti, tako da su Cesto
dodeljeni tasteri za korisnike koji mi§ koriste desnom rukom Q, W, A, S, Z i X.

Organizovanje ,vrucih” tastera

., Vruéi® tasteri su dodeljeni i organizovani u Tools=>Customize=yKeyboard okviru za dijalog, kao
Sto je prikazano na slici 2.31. Ovaj interfejs omogucava da lako vidite sve ,,vruce* tastere (koji se
u listi zovu precice). Ako pokusate da unesete postojeci ,,vruci® taster, SolidWorks ¢e upozoriti da
je taster dodeljen drugoj komandi i pitace da li Zelite da izbriSete drugi primer ,,vruceg* tastera i da
aktivirate novi. Takode mozete da odStampate ili kopirate u Clipboard listu samo onih komandi koje
koriste ,,vruce* tastere.

Posto je lista komandi duga, dostupna je funkcija Search, a strelica padaju¢eg menija prikazuje
samo komande iz izabranog menija. Lista komandi je organizovana po nazivima menija, a meniji su
izlistani onako kako se pojavljuju u interfejsu. SreCom, SolidWorks ovde na kartici Keyboard omo-
gucava da pomocu zaglavlja kolone sortirate listanje menija, komandi i ,,vru¢ih® tastera u abeced-
nom redosledu jednostavnim klikom na zaglavlje kolone. To je veoma prilagodljiv interfejs, jedna
od mojih omiljenih promena interfejsa u poslednjih nekoliko izdanja ovog programa.
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Tools=y Customizesy Keyboard — interfejs ,vru¢eg” tastera

Toolbars H Commands || Menus | Keyboard Optiunsl

Cateqgory: |A\I Caommarnds M [ Print List. .. ] [ Copy List ]
[ &nky show commands with shorbouts assigned Reset to Defaults
i | Bemove shortaue
Category Command Shortcut({s) g

File Mew. . Chrl+n

File Open.. Chrl+C

File '[j' Close..

File el 52 Ctrl+s

File Save As..

File Save Sheet Format,,

File Save All..

File Find References.,

File Page Setup..

File Print Preview.

File Print.. Chrl+P

File Pack and Go..

File Send Ta..

File Properties..

File Recent File..

I
e v
Description

Upotreba tastature

Pomeranje izmedu misa i tastature moze da bude veoma dosadno i da vam oduzme puno vremena.
Pored pristupa ,,vruéim* tasterima, mozete da upotrebite jo§ jedan metod tastature i tako ustedite
vreme. Mnogi korisnici su navikli da koriste kombinaciju Alt tastera za otvaranje stavki menija.
Vecina stavki menija u Windows programima sadrzi jedno podvuceno slovo.

Da biste pristupili meniju najviSeg nivoa, drzite pritisnut taster Alt i pritisnite podvuceno slovo za
odredenii meni, a zatim samo pritisnite podvuceno slovo u meniju da biste pristupili specifi¢cnim
komandama. Ova tehnika omogucava da pretrazite interfejs bez upotrebe misa. Na primer, da biste
napustili SolidWorks, umesto da koristite mi$ i kliknete na crveni X u gornjem desnom uglu, samo
pritisnite Alt+F, X. Na slici 2.32 mozete da vidite da je F podvuceno za File kao $to je X za Exit.

Terminologija u dokumentaciji SolidWorksa postaje veoma zbunjujuca kada je
» = - re¢ o Alt-tasterima (ubrzanim tasterima). Osnovna klasa tastera su precice, koje
mogu da budu ubrzani tasteri ili precice sa tastature. Kako su one dobijene iz menija precica i linija sa
alatkama Shortcut nije jasno. Ipak, u ovoj knjizi menije sa prec¢icama nazivam RMB (right mouse button -
desni klik misa) meniji, ubrzane tastere Alt-tasteri, a precice sa tastature ,vrudi” tasteri, $to je mnogo
razumljivije u standardnoj upotrebi nego sto je u terminologiji dokumentacije.
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Ubrzani tasteri u meniju File

[ | mew. Crl+
2 | open crl+0
7 | Close Ctrl+w
5| v

& [save ctrl+s
Save As... Alt+5

ﬁ Save Al

¥ | Reload.

Find References...
Page Setup...

ﬁ Print Preview,..

2 |Print... Clrl+P
3D Printing 4
Padcand Go...

Send To...
Properties...

1 Chapter 2 - Simple Part.SLOPRT

2 F+\2009'0n CDYChapter 01YChapter 1 - Features 2009.5LDPRT
3 Fi\solidProfessor\CSWA-P\CSWaAparts, SLDPRT
4F:\5olidProfessor \CSWA-PICSVWAPart2, SLDPRT

5 C:\Documents and Settings\Matt My Documents'\Part1. SLOPRT

Browse Recent Documents... R

Exit Alt+

Customize Menu

Potencijalno moZzete da naidete na konfliktne situacije kada koristite Alt tastere. Kombinacije Alt+
jos jedan taster sa tastature predstavljaju ispravnu upotrebu kombinacije ,,vru¢ih* tastera. Ako kori-
stite bilo koju kombinaciju Alt ,,vrué¢ih® tastera, verovatno ¢ete videti ovakav konflikt. U slu¢aju
konflikta, kombinacija ,,vru¢ih® tastera ¢e dobiti prioritet nad Alt-tasterom.

Maniji broj ikonica

Da bi maksimizirali koristan prostor na monitoru, mnogi korisnici SolidWorksa teze da minimizi-
raju broj ikonica u linijama sa alatkama na ekranu ili da ih poredaju u dva reda linija sa alatkama. To
mozete da uradite pomoéu Command Managera, padajucih linija sa alatkama, S linije sa alatkama,
linija desnog klika i ,,vruc¢ih® tastera i uklanjanjem neupotrebljenih ikonica, kao i drugim ovde opi-
sanim tehnikama.

Ako imate nepretrpan radni prostor, to je svakako dobro, ali je ipak na prvom mestu svrha interfejsa
da imate lak pristup komandama. Treba da napravite ravnotezu izmedu previse i nedovoljno. Sto
viSe vrsta poslova obavljate u SolidWorksu, bi¢e potrebno da imate dostupno vise alatki. Ako krei-
rate samo relativno jednostavne masinske delove i crteze, neophodno vam je manje dostupnih alatki
nego nekome ko radi slozene sklopove od plasti¢nih delova sa renderovanjima i animacijom.

Pristupi uredaja

Ako nikada niste koristili Spaceball ili slican uredaj za manipulisanje prikazom, trebalo bi da raz-
motrite mogucénost njihovog koriséenja. To su odli¢ni uredaji i rade mnogo vise od samog okretanja
prikaza. Vecina uredaja takode ima nekoliko dugmadi za podesavanje koje mozete da povezete sa
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stavkama menija. Oni mogu da pomeraju prikaze crteza, delove unutar sklopova, pa ¢ak i da mani-
pulisu selektovanim objektima u drugim Office programima i Web pretrazivac¢ima.

Delovi izdanja 2009 ove knjige su bili napisani na Tablet PC-ju. Tabla mozda nije idealna za duzu
upotrebu SolidWorksa, ali ja je redovno koristim za prezentacije, pa ¢ak i za modelovanje kada
zelim da crtam linije rukom, a ne kursorom. Stylus nije toliko intuitivan kao olovka, ali je bolji
osecaj upotrebljavati njega nego crtati misem.

Makroi

Makroi su kratki delovi programskog koda koji imaju odredenu funkciju. Veéina makroa je name-
njena za jednostavne zadatke koji se vi§e puta ponavljaju, kao $to su menjanje selektovanih dimen-
zija na Cetiri decimalna mesta ili uveliCavanje ekrana da razmera bude 1:1 (prava veli¢ina). Makroi
mogu da se snime, da se napisu od nule ili da snime odredenu akciju koju ¢ete upotrebiti kao startnu
tacku, a zatim nastaviti ruéno. Snimljeni makroi ne mogu uvek da snime delove akcije koje Zelite da
ugradite u makro, ali mozete ru¢no da ih modifikujete 1 ukljucite bilo $ta Sto mozete da programirate
koriste¢i VBA (Visual Basic for Applications), koji je ukljucen u osnovni SolidWorks paket bez
dodatne naplate.

Da biste pristupili makroima pomocu ,,vruéih“ tastera, pratite sledece korake:

1. Kreirajte direktorijum u instalacionom direktorijumu SolidWorks pod nazivom macros.
2. Kopirajte makroe u ovaj direktorium.

3. Pokrenite (ili restartujte) SolidWorks.

4. Idite na Tools= Customize=> Keyboard.

5

Skrolujte do dna liste pod kategorijom Macros i dodelite ,,vruce* tastere isto kao §to biste
uradili za standardne komande SolidWorksa.

Bez obzira da li ste vesti u pisanju ili snimanju makroa ili samo koristite one koje ste uzeli od dru-
gih korisnika, oni mogu da vam ustede veoma mnogo vremena i nude funkcionalnost kojoj, inace,
ne biste mogli da pristupite. Mnogi od mojih makroa su zastareli pored funkcija koje su ukljucene
direktno u SolidWorks.

Snimanje prilagodenih podesavanja interfejsa

Kada podesite menije i linije sa alatkama, izaberete boje i upotrebu ,,vru¢ih* tastera i povezete svoje
makroe, verovatno ne zelite da izgubite ova podeSavanja kada reinstalirate program ili promenite
racunar. Mozda jos jedan korisnik Zeli da deli vasa podeSavanja ili mozda Zelite da ih prebacite na
svoj kuéni racunar (na primer, za modelovanje novog krova ili kuéice za pse). Sre¢om, ova podesa-
vanja su prenosiva.

Mozete da upotrebite Copy Settings Wizard za snimanje ovih podeSavanja u fajl. Pristupite ovom
wizardu tako Sto éete izabrati Starte> Programse> SolidWorks 2009=> SolidWorks Tools=> Copy
Settings Wizard. Na ovaj nacin kreiracete fajl sa ekstenzijom *.sldreg. Mozete da vratite podesava-
nja tako sto ¢ete dvostruko kliknuti na ovaj fajl na racunaru koji ima instaliran SolidWorks.

Mozda ce biti potrebno da imate pristup administratora na vas racunar da biste
primenili fajl registra za SolidWorks.
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Podesavanja SolidWorksa su, u stvari, podesavanja Windows registra. Fajl koji je snimio wizard je
fajl registra koji ima drugaciju ekstenziju, Sto spre¢ava da lako bude promenjen. Snimljeni fajlovi
Windows registra imaju ekstenziju *.reg i integrisite ih u registar tako Sto ¢ete dvostruko kliknuti
na njih. Ako ne poznajete Windows registar, ne bi trebalo da vrSite promene, zato Sto ¢ak i male
promene mogu da izazovu ozbiljne probleme sa operativnim sistemom, instaliranim programom ili
¢ak i sa hardverom. PodeSavanja koja su snimljena pomoc¢u Copy Settings Wizarda su bezbedna za
prebacivanje izmedu raunara. Da bi Copy Settings Wizard radio, treba da imate administratorski
pristup racunaru. Copy Settings Wizard je prikazan na slici 2.33.

Copy Settings Wizard

& SolidWorks Copy Settings Wizard

r welcome to the Solidworks Copy Settings Wizard

2] [ This wizard allows wou to save or restore cuztomization settings for Solidwarks
toolbars, shortouts, menus. and spstem preferences.

Choose which task pou would like to perform:

Save Settings -
Save the Solidworks 2007 settings for matt ta a file.

Restore Settings -
Restore Solidworks zettings from a file,

Rad sa viSe prozora dokumenta

U SolidWorksu ¢ete mozda ponekad imati priliku da radite na jednom delu istovremeno, ali ¢ete
¢esée imati otvoreno vise dokumenata odjednom. Ovo je uobicajena situacija za vecinu korisnika.
Sre¢om, SolidWorks ima nekoliko metoda za rad sa “previse informacija” koji ¢e pomoci da se
krecete kroz sve njih.

Upravljanje prozorima
Kao i vec¢ina Windows programa, SolidWorks moze da ureduje otvorene prozore dokumenta na
nekoliko nacina koji su dostupni kroz meni Windows (vidite sliku 2.34):

B Cascade - najkorisnije za pristup dokumentima koje ¢ete modifikovati jedan po jedan
B Tile Horizontally - najkorisnije za Siroke i kratke delove

B Tile Vertically - najkorisnije za visoke, uske delove ili za dokumente gde Zelite da
uporedite stavke u FeatureManageru

B Arrange Icons - Kada su prozori minimizirani u ikonice, ova selekcija ureduje ikonice,
pocevsi od donjeg levog ugla prozora.
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Meni Window

[ windowp], Help ﬁl

Viewport 4
% New Window

] Cascade

E Tile Horizontally
1 | Tile vertically
Arrange Icons
Close All

Chapter 33 Robot Assembly.SLDASM *

Sketch1 of Parti =

Browse Open Documents... Ctrl-Tab

Customize Menu

Slike na slici 2.35 su namenjene da prikazu uredenje prozora, a ne sadrzaje prozora. Osim toga, ne
zaboravite da mozete da upotrebite taster F9 za zatvaranje FeatureManagera, taster F10 za ukla-
njanje linija sa alatkama i kreiranje dodatnog prostora u interfejsu kada uredujete nekoliko prozora
u grafickom prozoru i taster F11 za uklanjanje delova interfejsa, $to omogucava rad preko celog
ekrana.

Menjanje prozora

Mozete da upotrebite nekoliko tehnika za prebacivanje sa jednog prozora na drugi. Klikom na meni
Window prikazacete listu otvorenih prozora dokumenta (pogledajte sliku 2.34). Zatim, mozete da
izaberete zeljeni prozor direktno iz ovog menija. Ako imate vise otvorenih prozora, pojavice se
opcija More Windows na kraju liste, kao $to je prikazano na slici 2.36. Klikom na ovu opciju otvo-
rice se poseban prozor koji omogucava da izvrsite izbor iz kompletne liste.

Kada je otvoren manji broj prozora, najjednostavniji nacin da se prebacujete sa jednog prozora
na drugi je da pritiskate tastere Ctrl+Tab. Ovo je standardna tehnika Windowsa koja funkcionise
i u drugim Office programima. Ctrl+Tab vas vodi u jednom pravcu u listi otvorenih prozora, a
Ctrl+Shift+Tab vas vodi u suprotnom pravcu kroz listu. Pocevsi od izdanja 2008, Ctrl+Tab otvara
interfejs Open Documents (vidite sliku 2.36) - on omogucéava da vizuelno izaberete dokument koji
zelite da otvorite.

Pored toga, ,,vruéi* taster R, prema standardnom podesavanju, otvara okvir za dijalog Recent Docu-
ments, sli¢an listi Recent Documents u meniju File. Ovome mozete da pristupite i koris¢enjem
menija File, ako je potrebno. Okvir za dijalog Recent Documents je prikazan na slici 2.37.
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Uredenja prozora: Cascade, Tile Horizontally i Tile Vertically
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SLIKA 2.36

Okvir za dijalog Open Documents

Dpen Documents

- it P it e s St Tt B s
T — i

e 5T —

SLIKA 2.37

Okvir za dijalog Recent Documents

RBecent Documents

ﬂilMH'ﬂ—mi_ﬁml—llﬂ—rlﬁ"
Sty B By TR

[ mpre— R — e [ ——

Vezba: Upoznavanje interfejsa

Do sada niste naucili mnogo o kreiranju delova, sklopova i crteza u SolidWorksu, ali ste naucili pri-
li¢no puno o interfejsu. U ovoj vezbi ste¢i ¢ete prakticno znanje o manipulisanju interfejsom - ona
je namenjena da poboljsa sledeée vestine:

B dodavanje i uklanjanje linija sa alatkama
B dodavanje i uklanjanje dugmadi u linijama sa alatkama

B dodavanje i uklanjanje stavki iz padajucih menija i RMB menija
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podesavanje CommandManagera
podesavanje ,,vruc¢ih® tastera

povezivanje ,,vruéeg™ tastera sa makroom

menjanje boja interfejsa

Kopiranje postojecih podesavanja
Bez obzira koja su vasa pocetna podeSavanja, verovatno ne Zelite da ih izgubite. Pre nego $to poc-

nete da vrSite promene na sistemu, treba da snimite postojeca podesavanja u fajl iz kojeg mozete da
ih vratite. To mozete da uradite pomoc¢u Copy Settings Wizarda, kao $to je prikazano na slici 2.38.

Copy Settings Wizard

& SolidWorks Copy Settings Wizard
r welcome to the Solidworks Copy Settings Wizard

2] [ This wizard allows wou to save or restore cuztomization settings for Solidwarks
toolbars, shortouts, menus. and spstem preferences.

Choose which task pou would like to perform:

Save Settings -
Save the Solidworks 2007 settings for matt ta a file.

Restore Settings -
Restore Solidworks zettings from a file,

Da biste upotrebili Copy Settings Wizard, pratite sledece korake:

1. Zatvorite SolidWorks.

2. Kliknite na Startep Programs=>SolidWorks 2009=>SolidWorks 2009 Tools=> Copy
Settings Wizard.

Izaberite Save Settings i kliknite na Next.
4. Unesite lokaciju i naziv za fajl.

Izaberite stavke koje zelite da snimite. Za ovu vezbu, uverite se da su izabrane sledece
opcije: Keyboard Shortcuts, Menu Customization, Toolbar Layout i All Toolbars.

6. Kliknite na Finish. Potrazite lokaciju gde ste snimili fajl i uverite se da se on tamo i
nalazi.
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Podesite sve stavke interfejsa na njihova
standardna podesavanja

Interfejs mozete da podesite nazad na standardna podeSavanja koristeci jedan od dva metoda. Prvi
metod, koji se zove modifikovanje Windows registra, mozda nije dostupan svim korisnicima. On
zahteva administratorski pristup ra¢unaru i dobro poznavanje Windowsa.

B Modifikovanje Windows registra moze da bude opasno ako napravite gresku.
Nemojte da pokusavate da koristite ovaj metod ako ne znate ta¢no $ta radite.

~PAZINIALS

Da biste vratili standardna podesavanja SolidWorksa, pratite sledece korake:

Zatvorite SolidWorks.
Kliknite na Start=>Run.
Ukucajte regedit i kliknite na OK.

Potrazite slede¢i klju¢: HKEY CURRENT USERDSoftwareDSolidWorksDSolidWorks
2009 ili odgovarajuci direktorijum za verziju koju koristite.

b=

5. Da biste vratili sva podesavanja u SolidWorks na standardna podesavanja, promenite

VA1

naziv celog direktorijuma SolidWorks 2009 tako da sadrzi “(old)” na kraju naziva fajla.
6. Zatvorite Registry Editor.

7. Direktorijum je ponovo kreiran kada se ponovo pokrene SolidWorks i kada su unete
standardne vrednosti. Ako treba da vratite prethodni direktorijum, mozete da izbrisete
novi i da promenite naziv starog, tako Sto ¢ete ukloniti “(old)” iz naziva fajla.

Drugi metod je manje rizi¢an, ali i manje kompletan — treba da idete na glavne lokacije i upotrebite
alatke koje su obezbedene za vracanje podeSavanja na standardne vrednosti. Restartujte SolidWorks
i kreirajte novi prazan dokument (ne mozete da prikazete okvir za dijalog Customize bez otvorenog
dokumenta). Da biste pristupili opcijama za resetovanje interfejsa, uradite sledece:

1. Kliknite na Tools=>Options=p General=»Reset i idite na donji levi odeljak okvira za
dijalog.

2. Kliknite na Tools=)Customize=p Toolbars=»>Reset i idite na donji levi odeljak okvira za
dijalog.

3. Kliknite na Tools=>Customize=>Menus=>Reset All 1 idite na desnu stranu okvira za
dijalog.

4. Kliknite na Tools=»Customize=pKeyboard=pReset to Defaults i idite u gornji desni
odeljak okvira za dijalog.

5. Kliknite na Tools=>Customize=>Options; postoje tri dugmeta Reset to Defaults duz leve
strane okvira za dijalog.

Podesavanje CommandManagera

Sada, kada ste vratili standardna podesavanja, mozete da pocnete da podesavate interfejs pomocu
CommandManagera. Da biste to uradili, otvorite dokument dela ili kreirajte novi, zatim kliknite
desnim tasterom misa bilo gde u CommandManageru i iskljucite opciju Use Large Buttons with
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Text, kao Sto je prikazano na slici 2.39. Kada to uradite, ispred opcije ne bi trebalo da se nalazi
oznaka potvrde.

SLIKA 2.39

Iskljucite opciju Use Large Buttons with Text.

o - w - '
et Mew Bl of | Exploded Explode | Instar
¥ | Motion | Materials View Line
_study Sketrt
i ¥ || CommandManager
[4.]| Use Large Buttons with Text N
, . 60,
f0 |20 to 30
12| atian

Zatim, dodajte neke linije sa alatkama u CommandManager na sledeci nacin:

1.

SLIKA 2.40

Kliknite desnim tasterom misa na kartice CommandManagera i izaberite Customize
CommandManager.

Kliknite na ikonicu New Tab na desnom kraju kartica CommandManagera i izaberite
Surfaces, Sheet Metal i Annotations. Iskljucite karticu Sketch, tako $to ¢ete kliknuti
desnim tasterom mi$a na nju i izabrati Hide Tab. Ikonica nove kartice je prikazana na slici
2.40.

Dodavanje kartica u CommandManager

|-'1||-l-'-1.--|-| e | Beesd | o |-."*ft'\r--"|-J L L - J
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U okviru za dijalog Customize ukljucite opciju Large Icons.

Ukljucite liniju sa alatkama Sketch, ali ne unutar CommandManagera, i upotrebite karticu
Toolbars okvira za dijalog Customize. Postavite liniju sa alatkama Sketch na desnu stranu
prozora.

Ukljucite liniju sa alatkama Standard Views i prevucite je na desni kraj
CommandManagera. Sada izvucite nekoliko dugmadi sa nje, kao §to su dugmad za prikaz
Bottom, Left ili Back.

Na kartici Commands okvira za dijalog Customize izaberite unos Flyouts i prevucite bilo
koju vrstu padajuceg menija linije Standard Toolbar iz okvira za dijalog Customize na
liniju sa alatkama Menu Bar. Na slici 2.41 prikazan je ovaj korak ,,u akciji®.

Iskljucite okvir za dijalog Customize i kliknite desnim tasterom misa na liniju sa alatkama
Heads-up View.

Iskljucite alatke koje necete da koristite na liniji sa alatkama Heads-up View i kliknite
van menija kada zavrsite.

Prevucite kursor preko padajuc¢eg menija glavnog menija i upotrebite ¢iodu da zakacite
meni i ostavite ga da bude otvoren.
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10. Idite na Tools=>Customize=>Options i kliknite na dugmad Show All za Shortcut
Customization i Menu Customizations. Na taj nacin ¢ete ukloniti dvostruke strelice u dnu
RMB menija. PodeSavanje je prikazano na slici 2.42.

SLIKA 2.41

Dodavanje padajuc¢ih menija u liniju sa alatkama Menu Bar
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SLIKA 2.42

Uklanjanje skra¢enih menija
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11. Dok se i dalje nalazite u meniju Tools=>Customize, prebacite se na karticu Toolbars i
iskljucite opciju Context Toolbar Settings=>Show On Selection da biste iskljucili
kontekstne linije sa alatkama levog klika ili iskljucite Show In Shortcut Menu da biste
vratili RMB menije nazad na njihovo stanje iz verzije pre 2008 (svi unosi u meniju koriste
tekst).

12. Kliknite i izvucite karticu PropertyManager (druga kartica sleva) iz FeatureManagera i
postavite je desno od FeatureManagera ispod kartica CommandManagera. Trebalo bi da
prikaz sada izgleda kao na slici 2.43.

71



- Uvod u SolidWorks

Prilagodeni interfejs SolidWorksa
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Mali padajuéi meni u donjem desnom uglu slike 2.44 je podsetnik linije sa alatkama Sketch koja
ne staje na ekran. Ovaj snimak ekrana je snimljen na monitoru od 12 in¢a sa velikim ikonicama pri
rezoluciji od 1.024x768. Pri ovako maloj rezoluciji dugacke linije sa alatkama ne staju na ekran, a
preostale ikonice mozete da aktivirate tako §to ¢ete kliknuti na dve male strelice na kraju linije sa

alatkama.

Prilagodavanje menija

Ako uvek obavljate istu vrstu posla, ili, jos bolje, ako nikada ne obavljate odredenu vrstu posla, onda
mozete da razmislite o prilagodavanju nekih menija i uklanjanju stavki koje nikada ne koristite. Pri-
lagodavanje se primenjuje i na glavne padajuce menije i na kontekstno osetljive RMB menije. Da

biste prilagodili meni, pratite sledece korake:

1. Kliknite na Insert=> Customize Menu. Ne zaboravite da je Customize Menu drugacije od

Customize.

2. Iskljucite stavke menija Sketch from Drawing, DXF/DWG, Object, Hyperlink i Picture

(vidite sliku 2.44). Kliknite bilo gde van liste da biste je zatvorili.

3. Kliknite na meni Insert da biste se uverili da su uklonjene deselektovane stavke.

72



Pregled interfejsa SolidWorksa m

Prilagodavanje menija Insert
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Picture...

Kliknite desnim tasterom misa na desni panel FeatureManagera.
Izaberite Customize Menu.

Iskljucite Section View. Kliknite bilo gde van liste da biste je zatvorili.

NS vk

Kliknite desnim tasterom misa na desni panel da biste se uverili da je Section View
uklonjen.

Menjanje boja interfejsa
Ova vezba ne zavisi od RealView moguénosti, ali kasniji rad ¢e zavisiti. Da biste otkrili da li je na

vasem racunaru omogucen RealView, uporedite verziju video kartice i drajvera sa listom na web
sajtu SolidWorksa. Na glavnoj stranici web sajta pratite link za Video Cards.

Pre nego §to zapocnete ovu vezbu, uverite se da je iskljucena ikonica RealView. RealView mozete

da iskljucite u View=p Display=>RealView Graphics.

Za vise informacija o RealView grafikama pogledajte
Poglavlje 5.

REFERENCGA

UNAKRSNA

Modifikujte boje koje su upotrebljene u interfejsu:

1. Idite na Tools=>Options=yColors. Uverite se da je uklju¢ena opcija “Plain (Viewport
Background color above)”.

2. Promenite boju za Viewport Background prvo u listi Color Scheme Settings na svetlosivu
boju, zatim kliknite na OK i uverite se da su podeSavanja primenjena.
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3.

Vratite se na Tools=»Options=> Colors, kliknite na dugme Save As Scheme i snimite
kolornu Semu kao Plain Gray.

Sada ukljucite opciju “Gradient” i podesite gornju i donju boju gradijenta (druga i tre¢a u
gornjoj listi). Kliknite na OK i proverite da li vam se dopada prikaz gradijenta.
Podesavajte boje sve dok ne budete njima zadovoljni.

Vratite se na Tools=»Options=> Colors, kliknite na dugme Save As Scheme i snimite
kolornu Semu kao Gradient. Na slici 2.45 prikazan je okvir za dijalog
Tools=>Options=y Colors.

Podesavanja boja

6.

Syviem Options - Colory
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[Clse soecfe mor for Shsced ¥

Erges noce
[C] ot st cxsiers it kg i b 1 gy
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Upotrebite padajucu listu Current Color Scheme u vrhu da biste promenili kolorne Seme
izmedu novosnimljenih Sema.

Dodavanje ,vrucih” tastera

Za mnoge korisnike ,,vru¢i® tasteri su sastavni deo svakodnevnog rada u SolidWorksu. Mozete jed-
nostavno da dodelite te tastere i da upravljate dodelama tako $to ¢ete uraditi sledece:

1
2
3.
4
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Kliknite na Tools=yCustomize=y Keyboard.
U tekstualno polje Search For ukucajte Options.
Kliknite u kolonu Shortcut i ukucajte O.

Ponovo kliknite u tekstualno polje Search For i ukucajte Customize.
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5. Kliknite u tekstualno polje pored Tools=>Customize unosa i pritisnite Ctrl+C. Odgovorite
sa NO na pitanje da li Zelite da promenite ,,vruci* taster. Zatim, pritisnite Ctrl+T.

6. Kliknite na OK da biste napustili okvir za dijalog Customize.

7. Pritisnite taster O da biste otvorili Tools=>Options. Kliknite OK da biste ga zatvorili.
8. Pritisnite Ctrl+T da biste otvorili Tools=> Customize. Kliknite na OK da biste izasli.
9

Pritisnite Alt+F, a zatim pritisnite X da biste izasli iz SolidWorksa.

Kombinovanje makroa sa ,vruéim” tasterima

Makroi su opisani u poglavljima 34 i 35, a u slede¢im koracima je opisano kako da povezete makro
sa ,,vruéim‘ tasterom:

W7 Mozete da upotrebite makro koji se zove rectangle.swp, a koji se nalazi na CD-u.

1. Potrazite instalacioni direktorijum SolidWorksa. Prema standardnom podesavanju, to je
direktorijum C:DPProgram FilesDSolidWorks.

Kreirajte direktorijum koji se zove Macros u direktorijumu SolidWorksa i u njega
postavite makro rectangle.swp.

Pokrenite SolidWorks.

Kreirajte novi prazan dokument dela.

o

Pritisnite Ctrl+T da biste pristupili okviru za dijalog Customize.
Kliknite na karticu Keyboard.
U tekstualno polje Search For ukucajte rectangle.

Kliknite na kolonu Shortcut pored liste Category of Macros i pritisnite R.

A P A

Kliknite na OK da biste zatvorili okvir za dijalog Customize.

10. Pritisnite R. Makro rectangle ¢e se pokrenuti i nacrtace skicu pravougaonika na ravni
Front, koji je centriran sa po¢etnom tackom.

11. Pritisnite Ctrl+S da biste pristupili Windowsovom standardnom ,,vru¢em* tasteru za
komandu Save. Delu dajte naziv rectangle.sldprt i snimite ga u direktorijum workspace.

12. Pritisnite Alt+F, a zatim X da biste zatvorili SolidWorks.

Upotreba Alt-tastera i ,,vru¢ih® tastera je malo preuveli¢ana u ovoj vezbi da biste se navikli da radite
sa njima.
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Zakljucak

Interfejs SolidWorksa je veoma pretrpan i moze da bude zbunjujuéi. Veéini funkcija mozete da
pristupite na viSe nacina, §to moze da bude dobro zato Sto nudi opcije, ali je i zbunjujuce, jer treba
da pamtite puno $toSta. Nije neophodno da znate svaki nacin za svaki posao - otkrijte koji nacin
upotrebe interfejsa vama najvise odgovara i koristite ga.

Imajte u vidu da se kod svakog novog izdanja SolidWorksa menja i interfejs i Cesto se koriste najra-
dikalnije opcije kao standardna podeSavanja. Zadrzite kopiju fajla podeSavanja tako da mozete brzo
da vratite podesavanja na drugom racunaru kada vam budu potrebna.

76



